
 

SESSION 1 
About Your Company 
In this session, students take on the role of a Chief Executive Officer (CEO) of a 

company. Students choose a company name and three main product lines. 

They open PowerPoint 2013 to begin a slide show that summarizes the 

performance of the business. Students make a title slide that contains a 

heading, student name, date, design, and logo. The logo is made by 

combining WordArt with shapes. The logo is saved as a picture file so that it can 

be used in other documents.  

Assignment 1: Set Up the Company 

Assignment 2: Make Folders for your Work 

Assignment 3: Introduction to PowerPoint 2013 

Assignment 4: Make a Title Slide with a Company Logo 

Session 1 Review: Identify Commands 

Session 1 Skill Review: Logo Design 

Session 1 Extension Activity: Company Slogans 

 

  

Each TechnoKids project 
consists of 6 sessions, 
which are divided into 
separate assignments. An 
assignment is an activity 
that takes about 20 
minutes to complete. 
 

Learn more about TechnoCEO 
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Session 1: About Your Company 

GETTING STARTED 

Overview 

In this session, students take on the role of a Chief Executive Officer (CEO) of a company. Students 

choose a company name and three main product lines. They open PowerPoint 2013 to begin a 

slide show that summarizes the performance of the business. Students make a title slide that 

contains a heading, student name, date, design, and logo. The logo is made by combining 

WordArt with shapes. The logo is saved as a picture file so that it can be used in other documents. 

 

Materials 

 PowerPoint 2013 

 PowerPoint 2013 Flashcards: Home, Insert, Design, and Drawing Tools Format tab 

(Optional) 

 Sample Presentation 

 Session 1 Review: Identify Commands 

 Session 1 Skill Review: Logo Design 

o Session 1 Skill Review 

o Competitor Logo sample file 

 

Teacher Preparation  

 Make the CEO folder available to students.  

 Determine a location for students to save their work during this project. 

 Print the flashcards listed in the materials list for this session. (Optional) 

 

Teaching Strategy 

In this project, students become Chief Executive Officers of a private company. Explain scenario 

to students. 

 

Congratulations! You have just been appointed Chief Executive Officer 

(CEO) of a company! With a lot of hard work and dedication, you will 

achieve great things for yourself and for your business. With the job of 

CEO comes a lot of responsibility and accountability – the decisions you 

make not only effect your company, but all of your employees who look 

up to you with admiration.  

 

As CEO you decide that it is time to sell shares in the company and go "public.” This 

means people will be able to buy stocks in your company. The money raised from selling 

stocks can be used to grow your company. In order to attract investors you must create 

an impressive presentation that summarizes the business operations. 

 

  

For every session, the 
Teacher Guide features 
an Introduction with a 
materials list, preparation 
advice, teaching strategies, 
lesson plans for each 
assignment, and learning 
objectives for the session. 
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In this session, students learn about the role of a CEO. Explain scenario to students. 

 

In this session, you will decide on the type of company you are running. You will also 

choose 3 products that your company produces and you will set retail prices for these 

items. Once your business is organized, you begin to make a presentation to summarize 

company performance by creating a title slide. 

 

Assignment 1 - Set Up the Company 

 

In this assignment, students take on the role of CEO and must invent a name and products for 

their company. Afterwards, they watch a sample presentation that summarizes the company 

performance for the company TechnoSkater. Introduce the following terminology: 

 

CEO: Stands for Chief Executive Officer. A CEO is the highest ranking officer of a 

company, whose job is to manage all business operations including marketing, strategy, 

financing, human resources, sales, public relations, and any other company activity. 
 

cost: The amount of money it takes to make the product. Cost includes manufacturing, 

packing, storage, shipping, utilities, employee wages, advertising, and the any other 

operating costs. 
 

retail: The amount the consumer pays to purchase the product.  

 

Assignment 2 - Make Folders for your Work 

 

In this assignment, students prepare their workplace for their new role of CEO by setting up a 

folder and subfolders. Encourage students to be aware of where they are saving their work – 

making sure they use this location to save all work. This is an excellent way to develop 

organizational skills. 

 

Assignment 3 - Introduction to PowerPoint 2013 

 

In this assignment, students are introduced to the PowerPoint 2013 environment. Students are 

asked to read a description of each part of the application window and then label a diagram. 

Encourage students to click around in the program to discover the function of each part. 

 

Next, they explore the ribbon. This is a great way to learn about the location of commonly used 

commands. One suggestion is to turn the activity into a scavenger hunt. You can give students 

"clues" to see if they can find the tab, group, or command. 

 

Assignment 4 - Add a Company Logo to the Title Slide 

 

In this assignment, students begin to make the presentation to summarize company 

performance by creating a title slide. The title slide includes a heading, student name, date, 

theme, and a logo. Introduce the following terminology: 

 

theme: A design that sets the position of slide content, color scheme, fonts, and effects. 
 

logo: Picture or symbol that is used to represent a company. 
 

WordArt: Designs that make text look like art. 

  

This section, for teachers, 
explains each assignment 
and gives helpful tips. 
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About Logos 

 

Teachers may want to demonstrate some popular corporate logos by bringing in well-known 

products to show students. Teachers can lead students in a class discussion about corporate 

logos. Some points to consider include: 

 

 how companies use a signature color or color palette to create a unified product line 

 how company logos are unique and distinct: it is rare that two companies have similar 

logos 

 how the design of a logo can add to the image of the company – the shape and 

arrangement of objects, the font and style of the text all send a message to consumers 

 

 

 

 

 

 

 

 

 

 

TEACHER TIP 

 

TechnoCEO has a marking sheet for grading the presentation. You may wish to show the 

TechnoCEO Marking Sheet to students so that they are aware of all the components of the 

completed project. The assessment tool is a customizable file and adjustments can be made to 

change any of the requirements of the final presentation. 

 

The TechnoCEO Marking Sheet is located in the Session 7 folder, which is in the TechnoCEO 

Resources folder. 

 

  
TechnoKids projects 
include multiple 
assessment tools. Sam
ple
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Lesson Plan 

Assignment 1 - Set Up the Company 

 What is a CEO? 

 Invent a company name. 

 Select the products to sell and strategically set a price. 

 View a sample presentation about the company TechnoSkater. 

 

Assignment 2 - Make Folders for your Work. 

 Make a CEO Office folder. 

 Create two subfolders (Workbook and Presentation) inside the CEO Office folder. 

 

Assignment 3 - Introduction to PowerPoint 2013 

 What is PowerPoint 2013? 

 Open PowerPoint 2013. 

 Label the parts of the PowerPoint 2013 window. 

 Change the view and answer questions. 

 Examine the ribbon and answer questions about the content. 

 

Assignment 4 - Add a Company Logo to the Title Slide 

 Open PowerPoint 2013 

 Add the heading Company Overview to the title placeholder. 

 Add Student Name and Date to the subtitle placeholder. 

 Select a theme and customize the colors and fonts. 

 Make a company logo using WordArt and shapes. 

o Type company name using WordArt. 

o Customize the fill, outline, and effects of the WordArt. 

o Draw a shape. 

o Customize the style, fill, outline and effects of the shape. 

o Change the object order to move the shape behind the WordArt. 

o Group the WordArt and shape together. 

 Save the logo as a picture. 

 Save the presentation. 

 Close PowerPoint 2013. 

 

The Lesson Plan lists the 
individual steps in each 
assignment. 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to independently 

complete each task. 

 

Content Knowledge: 

 

 understand the role of a Chief Executive Officer 

 recognize the purpose of presentation software 

 determine the company name, products sold, and retail price 

 understand how a logo is a graphic representation or symbol of a company 

 label the parts of the PowerPoint 2013 window 

 label the parts to the PowerPoint 2013 ribbon 

 

Technical Skills: 

 

Operating Environment 

 create a folder 

 open and close a program 

 save a presentation to a folder 

 

Presentation Skills 

 

 add text to a text placeholder 

 select a theme for the slide design 

 select a variant of the theme 

 create WordArt 

 customize the fill, outline, and effects of WordArt 

 draw a shape 

 customize the style, fill, outline and effects of a shape 

 resize, bend, and rotate objects 

 arrange object order 

 group multiple objects 

 save a picture as a file 

 

Applied Technology 

 view a presentation and examine the content 

 design a company logo 

 create a title slide for a presentation 

 

 

  

Learning Objectives are 
specified for each of the 
six sessions of the 
project. A checklist of all 
objectives is provided at 
the end of the project in 
Session 7. 
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Assignment 1: Set Up the Company 
 

You are the Chief Executive Officer (CEO) of a company that sells a 

product. In this project, you are going to create a presentation 

describing the financial success of your company. With this 

presentation, you hope to convince others to invest in your company.  

 

First, you must decide on a company name and the product that you 

sell. 

 

 

 

What is a CEO? 

CEO stands for Chief Executive Officer. The CEO is the highest ranking officer of a company. The 

CEO reports to a Board of Directors.  

 

The CEO is the chief decision maker about all operations of a company. A CEO is in charge of 

marketing, strategy, financing, human resources, hiring, firing, sales, public relations, and any 

other company activities.  

 

The CEO duties include: 

 Set the goals for the company. 

 Develop a strategy to meet the goals. 

 Communicate the strategy to others. 

 Hire a team to run the company. 

 Lead the team to meet the goals. 

 Set the budget. 

 Raise funds from investors. 

 Form partnerships with other businesses and people. 

 Present information about the company to the Board of Directors. 

 

 

 

1. What qualities do you possess that would make you a good CEO? 

  

  
 

  

Introductory information 
can be used for 
classroom discussions 
prior to using computers. 
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Pick a Company Name 

 

 

 Combine your name with your product - Sam’s Skateboards  

 Say it with initials – S.S. Super Skateboards 

 Salute your street – Cornwall Street Skateboards 

 Abbreviate your name – SkateB 

 Say what you do – Skateboards for Sale 

 Be first in the telephone book – AAAmazing Skateboards 

 Be last in the telephone book – ZZZany Skateboards 

 Link what with where – Skate Ramp or Skate Park 

 Link benefit with product with superiority – Swift Skateboards Supreme 

 Make a name for yourself – Sam’s 

 Say what your customers should do – Skateboard for Fun 

 Nominate your neighborhood – Village Skateboard 

 Tell of your town – Binbrook Skateboards 

 

 

2. What do you want to call your company? 

  

  
 

 

 

3. Why did you choose this name for your company? 

  

  
 

 

 

 

 

 

  

You are going to be a CEO of your own company. Below 

are some tips for naming your company. 

Students choose 
particulars for their 
company. This activity can 
be completed in the 
classroom to save 
computer lab time. 
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Select the Product to Sell 

 
 

 

4. What is the product type? 

  

 

 
 

5. What are the three product lines your company sells? 

 Product Line #1  

 Product Line #2  

 Product Line #3  

 

Set the Price of each Product Line 

 

6. What are the retail values for each product line? 
 

 Item Name Cost Retail Value 

Product Line #1  $50.00 $ 

Product Line #2  $75.00 $ 

Product Line #3  $100.00 $ 

As the CEO, you must decide upon the product that your company sells. You can only sell 

ONE TYPE of product, such as clothing, televisions, sun glasses, or skateboards.  
 

Once you have picked the product type, you must invent three product lines. You need to 

make up a name for each product line. Be creative! 
 

For example: TechnoSkater is a company that sells skateboards.  
 

The three product lines sold are: 

1. Radical Board 

2. Cool Board 

3. Pro Board 

You need to set a price for each product line. The cost for each product 

line has already been set at $50.00, $75.00 and $100.00.  

 

Cost is the amount of money it takes to make the product. Cost  is 

already set and should not be changed.  

 

You need to set a retail value for each product line. Retail value is the 

amount the consumer pays to purchase the product. The retail value 

cannot be more than double the cost price. For example if the product 

cost is $50.00, the retail value cannot exceed $100.00.  

Most TechnoKids projects 
include a student planner 
to build organization skills. 
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Watch a Sample Presentation 

 
 

 Open the CEO folder. (Ask your teacher where this is located.) 

 Double click Sample Presentation. 

 Watch the presentation. TIP: You may need to click the mouse to advance to each slide. 

 
 

Answer Questions about the Presentation 

 

7. What information is on the title slide? 

  

 heading: Company Overview, student name, date, logo, and design 

  

 

8. Look at the organization chart. What is the name of the Chief Executive Officer? 

  

 Mark MacDonald 

 

9. Look at the product sales chart.  

  

 a) What product line sold the most in the month of October? 

   

  Pro Board 

   

 b) What product line is selling poorly? 

   

  Radical  Board 

  

 c) What product line sold the most in the month of June? 

   

  Cool Board 

 

10. What information is on the Summary of Company Performance slide? 

  

 total yearly operating expenses, sales revenue earned in one year, earnings after 

expenses 

 

You are going to create a presentation that describes the financial 

success of your company. To get an idea of what will be in the 

presentation watch the following slide show about the company 

TechnoSkater. 

A sample file provides a 
model of a completed 
presentation. This 
provides inspiration. 
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Assignment 2: Make Folders for your Work 
 

It is important to be organized. What if an important customer, 

investor, or Board member came for an unannounced visit and 

wanted to know how the company was performing? You would 

look incompetent if you were unable to answer their questions 

because you had to look for lost files on your computer.  
 

To stay organized you will save your work in folders. 

 

 

Make a CEO Office Folder 

 Go to the location where you will save your work. (Ask your teacher how to do this.) 

 In a blank area in this location, right click the mouse and point to New. 

 Select Folder from the submenu.  

 Type CEO Office as a label for the folder. 

 Double click to open the folder. 

 

Create Subfolders 

Make a Workbook Folder 

 In a blank area in this location, right click the mouse and point to New. 

 Select Folder from the submenu. 

 Type Workbook as the label for the folder. 

 

Make a Presentation Folder 

 In a blank area in this location, right click the mouse and point to New. 

 Select Folder from the submenu. 

 Type Presentation as the label for the folder. 

 

Close the Folders 

 Close the folders by clicking the Close button in the top right corner. 

 

  
TECHNOTIP: To rename a folder,  

right click on its icon and select  

Rename from the shortcut menu. 

Students prepare for 
their work flow: 
 make a folder 
 make a subfolder 
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Questions about Folders 

1. Why is it important for a CEO to be well organized? 

 The CEO of a company should project an ideal, well organized image for his employees to 

 follow. Also, the CEO must be familiar with all departments of the company, so he or she 

 has a great deal of data to access, read, manage and store. 

 

 

2. What is the benefit of organizing folders before you have started a project? 

 You can plan a project ahead of time and create subfolders for the different parts of it. 

 When you are working on a project and saving it, the folders will already have been  

 created in an organized and systematic way.  

 

 

3. You will be working with two programs: PowerPoint 2013 and Microsoft Excel. In which 

subfolder will you save the slide show? In which subfolder will you save the spreadsheet? 

 The slide show should be saved in the Presentation folder. 

 The spreadsheet should be saved in the Workbook folder. 

  

 

 

4. Electronic folders are similar to paper file folders in a filing cabinet. What are the 

advantages of electronic folders? 

 Electronic folders can be easily and quickly accessed on a computer. 

 Electronic folders can be easily shared on a network or by email with many people. 

 Electronic folders do not use up resources such as paper and printer ink. 

 

 
 

 

 

TECHNOTIP: Name your files and  

folders with labels that tell about  

the information that is stored inside. 

For the paperless 
classroom, students can 
answer the questions in 
their digital workbooks 
using the latest version of 
Adobe Reader. The Teacher 
Guide includes answers. 
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Assignment 3: Introduction to PowerPoint 2013 
 

 

 

 

 

What is PowerPoint? 

PowerPoint is presentation software. It is used to make a 

presentation which has of a number of slides shown one after 

another on a computer screen.  

 

With PowerPoint a person can:  

 create presentations to organize information 

 provide a summary or outline of the main points of a project 

 show presentations to groups of people to share and communicate information 

 talk about topic while the audience views text and pictures related to the subject 

 animate words and graphics to emphasize important points  

 add sound effects to attract attention 

 add transitions between slides to hold the viewer’s interest 

 include notes for slides  

 print out paper copies of the presentation  

 

1. List professions that could use PowerPoint in their work. 

  

  

 

2. How could you use PowerPoint at school? 

  

  

 

Open PowerPoint 2013 

 Open PowerPoint 2013.  

Click Blank Presentation. 

– A blank slide appears in the Title Slide layout. 

 

Open Microsoft PowerPoint to learn about the work environment. 

Questions help students 
build critical thinking skills. Sam
ple
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Label the Parts of the PowerPoint Window 

3. Use the descriptions to label the parts of the window. 

  
Part Description 

file tab  A tab which displays file management options such as New, Open, Save, Save As, 

Print, Share, Export, and Close. 

ribbon A band along the top of the window that holds the quick access toolbar, title bar, 

tabs, commands, window controls, and other tools. 

slides tab A tab at the left side of the window used to display thumbnails of all the slides in the 

presentation. Use the thumbnails to view, delete, or move slides. 

title bar A bar at the top of the window that displays the file and program name. 

quick access 

toolbar 

A customizable toolbar that holds frequently used commands such as Save, Undo, 

Redo, or Repeat. 

view shortcuts A set of tools at the bottom of the PowerPoint window used to switch views. 

zoom slider A slider that changes the magnification level of the slide in the window. 

slide pane A pane in the middle of the screen used to display the current slide. 

window controls A set of controls used to minimize, maximize/restore, or close the program window. 

 

 

 

 
 

1. File Tab  4. Window Controls  7. View Shortcuts 

2. Quick Access Toolbar  5. Slides Tab  8. Zoom Slider 

3. Ribbon  6. Title Bar  9. Slide Pane 

  

Students learn about the 
Microsoft PowerPoint 
environment. 

Sam
ple



TechnoCEO  Session 1 

 

TechnoKids Inc.  1-15 

Change the View 

 

 

 Click Notes at the bottom of the window. 

– A pane opens. You can type speaker notes into this pane.  

 

4. How could you use speaker notes during a presentation? 

 
 

 

 

 Click Comments at the bottom of the window. 

– A pane opens on the right. You can view, add, and delete comments.  

 

5. How can comments from viewers help you to improve your presentation? 

 
 

 

 

 Study the View Shortcuts.  

 

6. Which View Shortcut will display slides as thumbnails to make it easy to sort? 

 
Slide Sorter 

 

 

 

7. Which View Shortcut will play the presentation? 

 
Slide Show 

 

 

 

 Drag the slider to the left and right.  

 

8. What happens when you drag the slider to the right? 

 
Zoom In 

 

  

Which view do you prefer? Depending on the task you want to 

complete there are several view options. Try them!  

Students are challenged to 
explore the Microsoft 
PowerPoint environment. 
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A Closer Look at the PowerPoint Ribbon 

 
 

 
 

 

 

9. The ribbon has tabs. Each tab holds commands that do a similar job.  

Draw a box around the Home tab. 

  

10. Each tab is divided into groups. A group is a collection of commands that do similar 

actions like format text. Draw a box around the Font group. 

  

11. Each group has commands. Commands are a button, box, or menu that tells the 

computer what to do. Draw a box around the Paste command in the Clipboard group. 

 

 

Questions About the Ribbon 

12. Look at the Home tab. In which group of commands can you change the format of text, 

such as selecting font, size, bold, italic or underline styles? 

 Font group 

 

13. If you want to add an object such as a picture, shape or WordArt, which tab should you 

choose? 

 Insert tab 

 

14. Click the Design tab. What choices can be made to the presentation from this tab? 

 You can select the background design and colors of the presentation. 

 

15. Which tab would you select to find multimedia effects that you can add to a slide? 

 Animations tab 

 

16. On which tab can you check your spelling? 

 Review tab 

 

 

Exit PowerPoint 2013 

 Click Close. 

The Ribbon is a band along the top of the window that 

holds the quick access toolbar, title bar, tabs, commands, 

window controls, and other tools. Have a closer look. 

Group Command 

Tab 

Students take a closer look 
at the Ribbon to answer 
the questions. 
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Assignment 4: Make a Title Slide with a Company Logo 
 

 

 

Open PowerPoint 2013 

 Open PowerPoint 2013.  

Click Blank Presentation. 

– A blank slide appears in the Title Slide layout. 

 
 

Add Company Overview as the Title 

 Click inside the Click to add title placeholder.  

 Type Company Overview. 

 

Add Student Name as the Subtitle 

 Click inside the Click to add subtitle placeholder. 

 Type your name. 

 Press ENTER. 

 Type the current date. 

 
  

As the CEO of a company you need to create a slide show describing 

the financial success of your company. With this slide show, you hope 

to convince others to invest in your company.  

 

In this assignment, you start the slide show by making a title slide. The 

title slide will contain the heading Company Overview, student name, 

date, theme, and a logo.  

In this assignment, 
students use PowerPoint 
to make a title slide. 
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Select a Theme and Variant 

 

 Click the Design tab. 

 Locate the Themes group and click the More arrow to view the gallery of design choices.   

 

 Hold the mouse pointer over each theme to view a Live Preview. 

 When you have made a choice, click on the theme to apply it to the slide. 

 In the Variants group, select a style option. 

 
 

 

Make a Company Logo using WordArt 

 
 

 Click the Insert tab, locate the Text group and click WordArt. 

 Click on a design from the WordArt gallery. 

 

 Type Company Name. 

You are going to add a theme to the slide show. A theme is 

a design that sets the position of slide content, color 

scheme, fonts, and effects. It is a good idea to set a theme 

because it gives the presentation a professional look. 

You are going to put a company logo onto the title slide. A logo is a picture 

or symbol that is used to represent a company. You are going to use 

WordArt to make the logo. 

 

WordArt is designs that make text look like art. WordArt allows text 

to be bent, colored, rotated, and stretched. By treating the text as an 

object, effects can be applied to create attractive words and titles.  

More  

TECHNOTIP: 

A red squiggly line 

may show up below a 

name. This is because 

the word is not in the 

computer dictionary.  

 

Do not worry! 

The line will not show 

up when the slide 

show plays. 

Step-by-step instructions 
illustrate how to: 
 select a theme 
 add wordart 
 use drawing tools 
 add shapes 
 assign object order 
 group objects 
 save a file as a 

picture 
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About the Drawing Tools Contextual Tab 

 
 

 
 

Customize the WordArt 

 

 Select the text inside the WordArt text box. 

 Explore the WordArt Styles group of the Drawing Tools Format tab to customize the 

company logo. 

   

TEXT FILL TEXT OUTLINE TEXT EFFECTS 

 Make further changes using the colored handles.  

 

 

 
 

 

 

 

  

Look for the contextual tab that shows up on the ribbon when you 

double click the WordArt. A contextual tab is an additional tab on the 

ribbon that appears when doing a task such as formatting WordArt. 

 

This tab has commands you can use to make the WordArt look great! 

There are many ways that you can customize the WordArt. You can 

change the color and outline of the letters. You can also apply a 

shadow, glow, reflection, bevel, 3D rotation, and a transformation.  

As well, you can resize, rotate, or bend the shape.  

 

change the size by dragging the 

square handles up, down, left or right 

rotate by dragging the arrow in a circular pattern 

bend by dragging the pink 

handles up, down, left or right 

TECHNOTIP: 

You can fill WordArt 

with a picture to 

create a cool effect. 

 

1. Click Text Fill. 

2. Click Picture. 

3. Type in search word. 

4. Find a picture. 

5. Click Insert. 

Helpful tips throughout the 
assignment ensure success 
and assist in 
troubleshooting. 
Sam
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Add a Shape 

 

 Double click the WordArt to show the Drawing Tools Format tab. 

 Find the Insert Shapes group and click the More arrow to view a gallery of shapes. 

 

 Click on a shape you like.  

 Click and drag to draw a shape that surrounds the WordArt image. 

 

 

Select a Shape Style 

 

 Explore the Shape Styles group of the Drawing Tools Format tab to customize the shape. 

    
SHAPE STYLE SHAPE FILL SHAPE OUTLINE SHAPE EFFECTS 

 Make further changes using the handles.  

 
 

 

 
 

  

You are going to draw a shape and place it behind the WordArt to 

make the logo stand out. When choosing a shape, keep in mind your 

type of product and what kind of shape is suitable. 

There are many ways that you can customize a shape. You can change 

the style, fill, and outline. You can also apply a shadow, glow, reflection, 

soft edges, bevel, and 3D rotation. As well, you can resize  

or rotate the shape.  

More  

The shape appears on 

top of the WordArt. You 

will move the shape 

behind the WordArt after 

you change the style. 

TECHNOTIP: 

Keep the formatting, but 

change the shape! 

 

1. Select the shape. 

2. Click Edit Shape. 

3. Click Change Shape. 

4. Select a new shape. 

rotate by dragging the arrow in a circular pattern 

change the size by dragging the 

square handles up, down, left or right 

Tips challenge students and 
provide enrichment 
activities. 

Some pages have been removed from this sample session. 
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Session 1 Review: Identify Commands 
 

Name each command and describe its function. 

 

Command Name  Function 

1.  Word Art  Insert decorative text  

2.  Text Effects  Apply a shadow, glow, reflection or 3-D rotation to text 

3.  Text Outline  Set text outline by formatting the color, width, and style 

4.  Text Fill  Fill text with a solid color, gradient, picture, or texture 

5.  Shape Effects  Apply a shadow, glow, reflection or 3-D rotation to a shape 

6.  Shape Outline  Set shape outline by formatting the color, width, and style 

7.  Shape Fill  Fills the shape with a solid color, gradient, picture, or texture 

8.  Shape Style  Apply a pre-set style to a shape 

9.  Send Backward  Send the selected object behind all other objects 

10.  Group  Combine multiple objects together to form one object 

 

/20 

 

 

 

  

Review lessons at the end 
of sessions provide 
activities to check and 
reinforce newly learned 
skills, concepts, and 
terminology. 
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Session 1 Skill Review: Logo Design 
 

A company logo is an important sales tool. A logo helps 

consumers identify one product among the many other ones. 

Companies design their logos to be unique and distinctive, so it 

is clear to consumers which company makes what product. 

For example, Coca Cola uses red as its signature color, 

whereas Pepsi Cola uses red, white, and blue.  

 

Now that you have created your own company logo, it is time to take a look at the competition. 

Follow the instructions to create a logo for your competitors, making sure it is different enough 

that your customers do not confuse the two products. 

 

1. Choose a company name for your competitor. This company makes the same product. 

For example, if you were in the skateboard business and your company is named 

TechnoSkater, you might choose SkateGreat as your competitor's name. 

  

2. Open PowerPoint 2013. Click Blank Presentation. 

  

3. Select the Insert tab, locate the Text group, and click WordArt.  

  

4. From the WordArt gallery, select a style that is different than the one used in your own 

company logo.  

  

5. Type the Competitor's Company Name. 

  

6. Format the WordArt to create a design that is different from your own: 

 
 Choose a different color from Text Fill.  

 
 Choose a different outline from Text Outline.  

 
 Apply an effect such as a shadow, glow, or reflection from Text Effects.  

  

7. From the Insert Shapes group on the Drawing Toolbar, select any shape. Click and drag 

the mouse so that the shape covers the WordArt. 

  

8. With the shape selected, click the Drawing Tools Format tab and format the shape: 

 
 Choose a theme from the Shape Style gallery.  

 
 Choose a different color from Shape Fill.  

 
 Choose a different outline from Shape Outline.  

 
 Apply an effect such as a shadow, glow, or reflection from Shape Effects.  

  

9. Select the shape by clicking the mouse on it once. From the Drawing Tools Format 

tab, locate the Arrange group. Select Send Backward.  

  

10. Holding the SHIFT key, click the mouse on the shape and on the WordArt. From the 

Arrange group, click the Group command and select Group.  

  

11. Right click on the frame. Select Save as Picture.  

Save the logo as competitor logo in the CEO Office folder. 

  

Skill Reviews are activities 
for students to practice 
the technical skills learned 
in the previous session. 
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Session 1 Extension Activity: Company Slogans 
 

Companies use slogans as an important marketing strategy to 

promote themselves and their products. When repeatedly heard, 

slogans can make consumers familiar with the company, the 

product, and the brand image.  

 

For example, the tractor and farm equipment company John 

Deere's slogan is "nothing runs like a Deere". This is true for both deer, 

which run fast, and the John Deere tractors, which are dependable 

and thus "run" well. 

 

Create a list of well-known slogans. Answer the following questions 

about the slogans. 

 

 What is the product? 

 What company makes the product? 

 Why did you remember the slogan? 

 Does the slogan rhyme? 

 Does the slogan use an expression you already know? Was it a play on words or a pun? 

 Is the slogan long or short? 

 How does the slogan represent the company and the product? What sort of image is 

conveyed? 

 What words are used in the slogan to give the image of the product or company? 

 

 

 

Create a slogan for your own company. Consider the following when creating the slogan: 

 

 What image do you want the company to have – fun, exciting, dependable, reliable? 

 How can you make your slogan easy to remember? 

 What words can be used to represent this image? 

 Will your slogan rhyme? 

 Will your slogan be a play on words, or use an expression that people already know? 

 Is your slogan long or short? 

 

 

 

When finished add the slogan to the slideshow in PowerPoint. 

 

 

 

 

Extension Activities at the 
end of sessions provide 
optional enrichment 
challenges. 
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